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Overview

This Writing Guide outlines the specific styles used by Mobile 365. When in doubt about the 
usage of grammar or a specific word, please check this document first. If no answer can be found, 
please consult a member of the Corporate Marketing team.

This Writing Guide provides the following:

• Standard usage of industry language and acronyms

• Document writing guidelines, including how to determine which template to use, how to use 
various formatting styles (boldface vs. italics vs. underlining), using graphics in Microsoft 
Word and PowerPoint, and how to build a table of contents

• Email style guidelines

• Trademark, copyright, and patent information

The following icon indicates where items can be found on Planet 365:
On Planet 365

Documents > Templates

Team contact information:

• Larry Loper: Vice President, Marketing (larry.loper@mobile365.com; +1 650 787 1675)

• Greg Matranga: Director, Corporate Marketing (greg.matranga@mobile365.com;  
+1 703 961 2215)

• Carmel Coscia: Director, Marketing & Communications EMEA 
(carmel.coscia@mobile365.com; +33 6 87 21 71 77)

• Jean Loh: Director, Marketing, Asia & Australia (jean.loh@mobile365.com; 
+60 3 6203 2713)

• Laura Mayhew: Manager, Corporate Marketing (laura.mayhew@mobile365.com; 
+1 703 961 2209)

• Jason Wauer: Manager, Interactive Media (jason.wauer@mobile365.com; +1 703 961 2208)

• Steve O’Reilly: Manager, Marketing Communications (steve.oreilly@mobile365.com; 
+1 703 961 2290)

Creating New Styles
If there is a language or writing issue you believe needs to be addressed, please bring it to the 
attention of Laura Mayhew by sending a descriptive email to laura.mayhew@mobile365.com.

If there is a branding, graphics, GUI, or Planet 365 Intranet issue you believe needs to be 
addressed, please bring it to the attention of Jason Wauer by sending a descriptive email to 
jason.wauer@mobile365.com.
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This section outlines the specific writing and language styles to be used when writing documents 
or email in English. If a question regarding grammar or word usage arises, check this document 
first and then the Chicago Manual of Style. In addition, some of the entries in this document are 
borrowed from WIRED Style. All corporate documents are written in American English.

For local spellings and practices, please use the spelling that is most familiar to your audience. 
This refers to words such as organization (American English) vs. organisation (Queen’s English). 
If you have any questions about this, please contact your regional Marketing director.

Numbers
2G (Second Generation)

A phrase used to describe networks whose capacity and design supports only voice services.

2.5G (Second-and-a-half Generation)

A stepping stone between 2G and 3G cellular wireless technologies. The term “second-and-a-half-
generation” is used to describe 2G systems that have implemented a packet switched domain 
in addition to the circuit switched domain. 2.5G does not necessarily provide faster services 
because bundling of timeslots is used for circuit switched data services (HSCSD), as well. For 
GSM, this typically means GPRS data networks; for CDMA, it refers to CDMA 1xRTT networks.

24x7x365

The way Mobile 365 describes our “365 days a year” quality of service, and how we refer to the 
support offered by our Customer Service department. Note the order of the numbers: 24 hours a 
day, seven days a week, 365 days a year.

NOTE: Do not use slashes to separate the numbers. Only use a small “x” to separate the 
numbers, with no spaces in between.

3G (Third Generation)

A phrase used to describe networks currently being deployed that have greatly increased 
bandwidth to enable support of both voice and data services.

3GPP (Third Generation Partnership Project)

A global collaboration between six partners: ARIB, CWTS, ETSI, T1, TTA, and TTC. The group aims 
to develop a globally-accepted third-generation mobile system based on GSM.

3GPP2 (Third Generation Partnership Project 2)

A collaborative third-generation (3G) telecommunications standards-setting project — comprising 
North American and Asian interests — developing global specifications for ANSI/TIA/EIA-41 
cellular radio telecommunication intersystem operations network evolution to 3G, and global 
specifications for the radio transmission technologies (RTTs) supported by ANSI/TIA/EIA-41. 
Their main focus is the CDMA2000 standards.

99.999% reliability

The way to write how Mobile 365 describes the quality of service offered by our P2P 
interoperability network. Can also use five 9s. Do not use 5 9s, 5-9s, 5 nines, or any other 
combination of the two words.

NOTE: Only use this phrase when referring to our P2P network.

Writing Guidelines
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Writing Guidelines

A
A2P (Application-to-Person messaging)

This term is typically used when a message originates from an application server, or when a 
person sends a message to an application server. An application server is typically used to record 
votes, send or receive content (text, images, audio, or video), or perhaps serve as a chat or 
gaming server. Contrast P2P.

a

Not capitalized in a title or heading — unless it is the first word.

acronyms

Typically, you should spell out the first mention within each document, with the acronym in 
parenthesis. From that point forward, use only the acronym. 

EXAMPLE

The Operator Charging Gateway (OCG) provides extensive billing capabilities. 
To purchase OCG services, contact Mobile 365 directly.

NOTE: Always take note of the initial capitalization used with acronyms, as the acronym is 
not necessarily comprised from the first letter of each included word. An example of this 
is the APEX Network (Application and Personal EXchange).

If drafting a technical document, such as a product specification or a user manual, you do not 
need to spell out each acronym, as it can be assumed that your audience knows what each 
acronym means. If you don’t know your audience’s knowledge level, spell out the first instance.

active voice

Use instead of passive voice.

CORRECT: The dialog displays.

INCORRECT: The dialog will display.

allow

Do not use. Use enable or lets instead.

CORRECT: This dialog enables you to change an object name.

INCORRECT: This dialog allows you to change an object name.

alphabetizing

When alphabetizing a glossary, use a letter-by-letter system. The following is an example of 
letter-by-letter alphabetizing:

New, Arthur

New, Zoe

newborn

newcomer

New Deal

new economics

alphanumeric pager

Can also use pager. Do not use text pager.
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am

Refers to the morning hours of the day, from midnight to 11:59 am. Always use in lowercase, 
with no periods after the letters. Do not use the forms A.M., AM, or a.m.

Americas

Refers to Canada, the United States, Mexico, Central America, and South America. 
Contrast North America, Central America, and South America.

and

Not capitalized in a title or heading.

APEX Network (Application and Personal message EXchange)

The Mobile 365 international mobile messaging and data network. Always capitalize “Network” 
when referring to it.

NOTE: Take note of the capitalization of this acronym, as not all words contribute to the 
acronym itself.

Application Programming Interface (API)

When plural, do not use an apostrophe (example: APIs). Only use an apostrophe if referring to a 
feature of a single API (such as, “The API’s menus are easy to use”). When discussing Mobile 365 
APIs, never use the apostrophe.

apostrophe	

Always use Microsoft Word’s “smart quotes” feature (also referred to as curly quotes or 
typographer’s quotes) for apostrophes. Smart quotes are generally considered to be more 
readable than straight quotes.

EXCEPTION: Websites and Web-based GUIs.

To turn on smart quotes, go to the Microsoft Word Tools menu, choose AutoCorrect…, and then 
click the AutoFormat As You Type tab. In the Replace as you type section, click the “Straight 
quotes” with “smart quotes” checkbox. Click OK.

When making acronyms plural, add an s with no apostrophe.

CORRECT: The APIs were finished and ready for release.

INCORRECT: The API’s were finished and ready for release.

appears

In technical documentation, do not use when referring to a dialog or window. Use displays instead.

CORRECT: The MMS Exchange window displays.

INCORRECT: The MMS Exchange window appears.

application

Use instead of program. Can also use product.

ARPU (Average Revenue Per User)

Measures the average monthly revenue generated for each customer unit, such as a cellular 
phone or pager, that an operator has in operation.
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B
back up

To duplicate data for storage purposes. Use backed up and backing up as verbs.

backup

One word. The noun referring to what you created (“My only backup was destroyed.”). 
The adjective, backup disk, is also one word.

bi-lateral

Two operators that are directly connected to one another for the purpose of exchanging 
communications traffic. Do not use direct connect.

Bluetooth

A short-range radio technology aimed at simplifying communications among Internet devices and 
between devices and the Internet. It also aims to simplify data synchronization between Internet 
devices and other computers. Note capitalization.

Products with Bluetooth technology must be qualified and pass interoperability testing by the 
Bluetooth Special Interest Group (SIG) prior to release. Bluetooth’s founding members include 
Ericsson, IBM, Intel, Nokia, and Toshiba.

boldface type

In technical documentation, boldface the words used to refer to all GUI items, including menu 
titles, menu items, field names, figure numbers, and table numbers.

EXAMPLE

From the File menu, choose Open.

boot

A verb used to describe the act of a computer as it starts up.

BREW (Binary Runtime Environment for Wireless)

An application development standard developed by Qualcomm, and used to download and use 
wireless games and applications on mobile devices. BREW is fully integrated for operators, 
from billing systems to download, and is currently deployed by Verizon and several large 
operators in Asia.

bring up

In technical documentation, do not use when referring to something that is the result of an action 
performed, such as clicking OK. Use displays instead.

CORRECT: The dialog displays.

INCORRECT: Bring up the dialog.

browser

Can be used with or without Web preceding it.
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bulleted list

Do not place any punctuation (periods, semi-colons) at the end of each item in a list of bullets 
unless there is a full sentence somewhere in the list. In this case, make each item in the list a 
complete sentence, ending each with a period. Each item in a bulleted list should start with a 
capital letter, regardless of whether or not it is a sentence.

NOTE: A bulleted list should never have more than three levels of indentation.

bullets vs. numbering

Only use a numbered list if you are writing steps in a technical documentation procedure. 
Use bulleted lists for all other list types.

C
callouts

Callouts are notes or warnings that alert the reader to important information. Callouts can 
be displayed in a column to the left of the main text column or in a note below the text, and 
provide tips on how to better use a feature of a software application, warnings about potentially 
dangerous actions, and general guidance to the user.

CAMEL (Customized Applications for Mobile networks Enhanced Logic)

A set of GSM standards designed to work on a GSM core network. They enable an operator to 
define services over and above standard GSM services. The CAMEL architecture is based on the 
Intelligent Network (IN) standards. 

capitalization

Capitalize the first letter of all major words in a chapter or section title (called initial 
capitalization). Do not use initial capitalization in a bulleted list or a numbered list, but do 
capitalize the first word in bulleted list items. The following words are not capitalized (unless they 
are the first or last word in a title): a, and, in, the, this, under, with.

When creating an index, capitalize top-level index entries but not second-level index entries. 
Contrast index.

Department names are capitalized, but the word department is not.

CORRECT: Sales department

INCORRECT: Sales Department

captions

In technical documentation, always include the name of the dialog if the figure is being included 
as a screenshot. If you are using a description as the caption (because the dialog has no official 
name, for example) keep it short. Place captions below the screenshot (never above or off to 
the side).

carrier

Do not use. Use operator instead. 

EXCEPTION: If a document is being distributed to a North American audience only, 
use carrier.
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case-sensitive

Always hyphenate.

CDG (CDMA Development Group)

The CDMA Development Group is an international consortium of companies who have joined 
together to lead the adoption and evolution of CDMA wireless systems around the world.

CDMA (Code Division Multiple Access)

A digital standard developed and deployed by a U.S.-based company, Qualcomm. CDMA enables 
multiple frequencies to be used simultaneously (spread spectrum).

Unlike competing systems such as GSM, CDMA does not assign a specific frequency to each user. 
Instead, every channel uses the full available spectrum. Individual conversations are encoded 
with a pseudo-random digital sequence. CDMA consistently provides better capacity for voice and 
data communications than other commercial mobile technologies, enabling more subscribers to 
connect at any given time, and it is the common platform on which 3G technologies are built.

CDMA2000

CDMA2000 is a name identifying the third generation technology that is an evolutionary 
outgrowth of cdmaOne™, offering operators who have deployed a second generation cdmaOne 
system a seamless migration path that economically supports the upgrade to 3G features and 
services within existing spectrum allocations for both cellular and PCS operators. 

CDMA2000 supports the second generation network aspect of all existing operators regardless 
of technology (cdmaOne, IS-136 TDMA, or GSM). This standard is also known by its ITU name, 
IMT-CDMA Multi-Carrier (1X/3X). Similar to, but incompatible with, WCDMA.

CDMA2000 1X

The first phase in the evolution to 3G is CDMA2000 1X (or 1 times [1x] 1.25 MHz operator), which 
improves packet data transmission capabilities and speeds in-network, and also boosts voice 
capacity by nearly two times over today’s CDMA capacities, supporting data speeds of up to 144 
Kpps. Also known as 1xRTT or CDMA 1xRTT.

CDMA2000 1X EV (CDMA2000 High Rate Packet Data Air Interface Specification)

Represents the second step in the evolution of CDMA2000; will bring data rates of up to 2 Mbps 
to the network. The CDMA 1xEV specification was developed by the Third Generation Partnership 
Project 2 (3GPP2).

CDMA2000 1X EV-DO (1X Evolution-Data Only)

3GPP2, a global 3G standards organization, adopted a new air interface standard for wireless 
Internet called 1X EV-DO. 1X EV-DO, officially known as IS-856, embodies a new air interface 
technology specifically designed for packet data, and offers bandwidth efficiency for data 
traffic that is 3-4 times greater than current 3G standards, such as WCDMA or 1xRTT. 1X EV-DO 
achieves a peak data rate of 2.45 Mbps on the forward link (from the Base Station, BTS, to the 
user) using only 1.25 MHz of spectrum. The technology is ideal for high-speed mobile, as well as 
fixed wireless Internet services.

CDMA2000 1X EV-DV (CDMA2000 1X Evolution for Data and Voice)

This technology evolution provides integrated voice with simultaneous high-speed packet data, 
video, and video conferencing capabilities. 1xEV-DV is backward compatible with IS-95A/B and 
CDMA2000 1x, enabling an operator to evolve their CDMA2000 systems.
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CDMA2000 3X

The second phase in the evolution of CDMA2000 3G technology, offering voice and data on a 5 
MHz operator (or three times [3X] the 1.25 MHz operator).

cdmaOne

cdmaOne is a brand name, trademarked and reserved for the exclusive use of CDG (CDMA 
Development Group) member companies, that describes a complete wireless system 
that incorporates the IS-95 CDMA air interface, the ANSI-41 network standard for switch 
interconnection, and many other standards that make up a complete wireless system.

cdmaOne is a digital mobile phone standard based on the CDMA principle. For migration to third 
generation mobile telephony, cdmaOne networks can be upgraded to the CDMA2000 broadband 
standard. cdmaOne supports the following frequencies: Cellular and PCS bands: 800 MHz, 
900 MHz, 1700 MHz, 1800 MHz, 1900 MHz, and all IMT-2000 bands (CDMA2000).

CD-ROM (Compact Disc-Read Only Memory)

Only use the acronym, and note hyphenation. It is never necessary to spell out the entire phrase.

cell phone

Do not use. Use mobile phone or mobile device instead.

Central America

Refers to Guatemala, Belize, Nicaragua, Honduras, El Salvador, Costa Rica, and Panama. 
Contrast Americas, North America, and South America.

checkbox

One word. In technical documentation, checkboxes are small squares in a GUI that enable the 
end-user to select multiple options. Contrast radio buttons, with which users may make only 
one selection.

checkmark

One word. In technical documentation, use click when you are referring to putting a checkmark in 
a checkbox.

choose

In technical documentation, use choose instead of select for menu items. Use select when 
choosing an option from a scrolling list or a pull-down list within a dialog.

CORRECT: From the File menu, choose Open.

INCORRECT: From the File menu, select Open.

click

In technical documentation, use when referring to the action where a user clicks an item to select 
it. In those instances, use “click Send” — do not use “click on Send” or “click on the Send button.” 
Also use click when you are referring to putting a checkmark in a checkbox.

client/server

Describes the network architecture in which a powerful, central computer (server) accepts 
requests for resources and services from many individual computers (clients). Client refers not to 
the person using the computer, but to the computer itself.
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close box

Lowercase, two words.

colon

Do not use a colon unless it is preceded by a complete sentence, or contains the phrase as 
follows or the following. 

EXCEPTION: When you are introducing a technical writing procedure, use a colon.

CORRECT: The writer’s job includes the following duties:

CORRECT: The writer’s job is as follows:

INCORRECT: The writer’s job duties include: writing, desktop publishing, and editing.

Do not capitalize the first word after a colon, unless you are introducing a technical 
documentation procedure on the next line. If a GUI item name contains a colon, omit it when 
referring to the name in text.

colors

All Mobile 365 templates contain pre-set document colors. Please do not add or change any 
colors in any document template. For the complete Mobile 365 color palette, please refer to the 
Mobile 365 Brand Guide.

comma

Place a comma after every item in a series before the “and.”

CORRECT: Corporate Marketing, Engineering, and Sales are some of the departments 
at Mobile 365.

INCORRECT: Corporate Marketing, Engineering and Sales are some of the departments 
at Mobile 365.

In technical documentation, place a comma after any introductory phrase that is four words or 
longer. Use a comma after a shorter clause only if it makes the meaning clearer.

CORRECT: From the File menu, choose Open.

CORRECT: For more information on configuring, see Chapter 3, Using MMS Exchange.

command

In technical documentation, do not use command when describing an action.

CORRECT: To place a copied item in a document, use Paste.

INCORRECT: To place a copied item in a document, use the Paste command.

computer

Use instead of machine. Can also use PC.

Control-Alt-Delete

Note spelling and hyphenation.

copyright

A copyright statement shall be included in each Mobile 365 document at the time that such 
document is produced. Use the following copyright statement in the footer of all external Mobile 
365 documents: © 2006 Mobile 365, Inc.

For more information on copyrights, please see page 40, “Trademarks, Copyrights, + Patents.”
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cross-network

Phrase used to describe the capability of Mobile 365 to deliver messages between previously 
incompatible operators, regardless of network type or geographical location. Can also use 
cross-operator and inter-operator.

EXCEPTION: If a document is being distributed only in North America, you can use 
cross-carrier or inter-carrier.

cross-operator

Phrase used to describe the capability of Mobile 365 to deliver messages between previously 
incompatible operators, regardless of network type or geographical location. Can also use 
cross-network and inter-operator.

EXCEPTION: If a document is being distributed only in North America, you can use 
cross-carrier or inter-carrier.

customers

Used to describe Mobile 365 clients. Do not use subscribers or end-users, as these apply 
to the people who buy and use mobile phones — they not direct customers of Mobile 365. 
Cross-reference subscribers and end-users.

D
dashes

Use an em dash (—), otherwise known as a long dash, when you need to use a dash in a sentence. 
Use no spaces before or after an em dash.

To create an em dash in Microsoft Word or PowerPoint, type the word prior to the em dash, 
do not include a space after the word, type two hyphens, and immediately type the next word 
in your string. Pressing the space bar then causes an em dash to be automatically created by 
Word or PowerPoint.

TYPE: Sponsored by Mobile 365--the global leader in mobile messaging and data services.

RESULT: Sponsored by Mobile 365—the global leader in mobile messaging and data services.

database

One word.

date format

Day, Month, Year (for example, 15 January, 2005, 15.01.05, and so on).

demo

Use either demo or demonstration.

depress

In technical documentation, do not use. Press a key — do not use hit or depress.

desktop

One word.

device name

Two words.
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dialog

Part of a graphical user interface (GUI) that displays on a computer screen and requests 
information from an end-user. A dialog displays, it does not appear. Do not use dialog box or 
dialog window.

direct connect

Do not use to refer to operators connecting directly to each other, as opposed to going through 
an intermediary such as Mobile 365. Use bi-lateral connection, or some derivative thereof. 
The phrase direct connect has been made popular in the U.S. mobile space by Sprint (together 
with Nextel), who uses it to refer to the push-to-talk walkie-talkie feature on their phones.

displays

In technical documents, a dialog or window displays, it does not appear.

DNS (Domain Name System)

The DNS is the system that translates Internet domain names into IP numbers (for example, 
209.203.234.42). A DNS server performs this translation. The network of computers that 
constitute the Internet maps domain names to their corresponding IP numbers. The data is then 
made available to all computers and users on the Internet. 

double-click

Always hyphenate.

download

The act of copying a document or application from a network or server to a personal computer.

drag-and-drop

Always hyphenate.

drop-down menu

Do not use. Use pull-down menu instead.

E
E.164

The ITU standard recommendation that provides the telephone number structure and 
functionality for the three categories used for international public telecommunication. 
All telephone numbers can be called if a number is dialed of up to 15 digits, made up of a one to 
three digit country code (CC), followed by the subscriber number (SN). The first few digits of the 
subscriber number can be a so-called National Destination Code (NDC), which can identify the 
type of telephone number you are calling.

EAIF (External Application InterFace)

A Nokia proprietary definition of the MMS MM7 functionality. Mobile 365’s A2P MMS hub 
supports EAIF, along with MM7. 

ebusiness

Note lack of hyphenation and capitalization. Do not use e-business, E-business, e Business, or 
Ebusiness (unless it starts a sentence). Can also use ecommerce.
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ecommerce

Note lack of hyphenation and capitalization. Do not use e-commerce, E-commerce, e Commerce, 
or Ecommerce (unless it starts a sentence). Contrast mcommerce. Can also use ebusiness.

EDGE (Enhanced Data rates for GSM Evolution)

A digital mobile phone technology that acts as a bolt-on enhancement to 2G and 2.5G (aka GPRS) 
networks. This technology is working in TDMA and GSM networks. EDGE (aka EGPRS or Extended 
GPRS) is a superset to GPRS, and can function on any network deploying GPRS (provided the 
operator implements the necessary upgrades). EDGE enables operators without a 3G license to 
compete with 3G networks by offering similar data services.

ellipsis points (…)

Do not use a space before an ellipsis point. Always use a space after an ellipsis point, unless it 
occurs at the end of a sentence. If an ellipses ends a sentence, it should be followed by a period, 
with no space in between.

email

Do not hyphenate.

EMEA

Refers to Europe, the Middle East, and Africa.

end-user

Used to describe the clients of Mobile 365’s customers. Always hyphenate. Can also use 
subscribers. Do not use customers, which refers to Mobile 365 customers.

enter

In technical documentation, do not use as a substitute for type.

CORRECT: When prompted, type your password.

INCORRECT: When prompted, enter your password.

ENUM (Electronic NUMbering)

A standard adopted by the Internet Engineering Task Force (IETF) that uses the domain name 
system (DNS) to map E.164 telephone numbers to Web addresses or URLs. 

extranet

A private network used to securely share part of a business’ information or operations with 
suppliers, vendors, partners, customers, or other external businesses.

F
fax

Note lack of capitalization.

filename

One word.
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five 9s

The way to write how Mobile 365 describes the quality of service offered by our P2P 
interoperability network. Can also use 99.999% reliability. Do not use 5 9s, 5-9s, 5 nines, or any 
other combination of the two words.

NOTE: Only use this phrase when referring to our P2P network. 

frame

Used in technical writing to describe the segments of a Web page. Each frame is built as a 
separate HTML file, and is embedded in a master file. Do not use pane or window.

CORRECT: In the left-hand frame of the Website, click Open.

INCORRECT: In the left-hand pane of the Website, click Open.

from

In technical documentation, use when referring to how to access something onscreen, such as a 
menu item. Do not use when referring to a toolbar. Use on instead.

CORRECT: On the toolbar, click Create.

CORRECT: From the File menu, choose Open.

INCORRECT: From the toolbar, click Create.

functionality

Use sparingly, if at all. Use functions or features.

G
GGSN (Gateway GPRS Support Node)

One of the two main GPRS nodes that provides the interface between the radio network and IP 
network. Contrast SGSN.

gigabyte (GB)

A gigabyte is a measure of computer data storage capacity, and is roughly a billion bytes. 
A gigabyte is two to the 30th power, or 1,073,741,824 in decimal notation. The prefix, “giga” 
comes from a Greek word meaning “giant.” Note the capitalization in the abbreviation.

glossary

In technical documentation, use letter-by-letter alphabetization in the glossary. 
See also alphabetizing.

GPRS (General Packet Radio System)

A radio technology for GSM networks that adds packet-switching protocols, shorter set-up 
time for ISP connections, and offers the possibility to charge by amount of data sent rather 
than connect time. GPRS provides for flexible transmission rates up to 20 or 30 Kbps (with a 
theoretical maximum of 171.2 Kbps), as well as continuous connection to the network.

Known as a 2.5 generation (or 2.5G) enhancement to GSM, GPRS was probably the most 
significant step towards 3G, requiring a similar business model and service and network 
architectures. GPRS began appearing in networks during 2000. MMS first launched on 
GPRS systems. 
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grayed-out

In technical documentation, use when referring to a feature that is not currently available. 
Always hyphenate. Can also use inactive.

GRX (GPRS Roaming eXchange)

The interconnecting network between GPRS networks carrying roaming data traffic. GRXs have 
also been promoted within the GSM Association as means for MMS interoperability (although not 
the best solution). They can be used for roaming inter-connection between 3G networks as well, 
as long as they have the bandwidth to support the heavier traffic.

GSM (Global System for Mobile communications)

One of the leading digital cellular systems, GSM is a digital standard introduced in 1991 and is 
the de-facto standard throughout Europe, the Middle East, Africa, Asia, and Canada. GSM is also 
deployed in the U.S. by multiple operators, including T-Mobile and Cingular. GSM uses narrowband 
TDMA (Time Division Multiple Access), which enables eight simultaneous calls on the same 
radio frequency.

GUI (Graphical User Interface)

A program interface that takes advantage of the computer’s graphics capabilities to make the 
program easier to use. There is never a need to spell out the acronym. Can also use UI.

H
handheld

One word. Can also use PDA.

handset

One word. Another way to refer to a mobile phone, a PDA, or a handheld device. Can also use 
mobile handset or mobile device.

heading

To provide clarity in Microsoft Word documents, always include a short introductory paragraph 
following headings, subheadings, or sub-subheadings.

high-tech

Always hyphenate. Use as both a noun and an adjective.

higher

In technical documentation, do not use when referring to system software. Use later.

CORRECT: MMS Exchange requires Windows 2000 or later.

INCORRECT: MMS Exchange requires Windows 2000 or higher.

hit

Do not use. Press a key — do not use hit or depress.
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HLR (Home Location Register)

The HLR is a key functional unit responsible for managing mobile subscribers on a mobile 
network. Two types of information reside in the HLR: all subscriber information (features, handset 
information and identifiers, and numbers), and part of the mobile information that enables 
incoming mobile calls to be routed to a subscriber. 

homepage

One word. Do not capitalize.

hostname

One word.

hyphenation

Turn off paragraph hyphenation to eliminate awkwardly broken words at the end of lines. 
In addition, do not hyphenate words in titles or headings. To turn off paragraph hyphenation in 
Microsoft Word, choose Paragraph from the Format menu. Click the Line and Page Breaks tab, 
then click the Don’t hyphenate checkbox.

I
iDEN (integrated Digital Enhanced Network)

Note unusual capitalization. iDEN is a mobile communications technology developed by Motorola 
that provides its users with the benefits of a trunked radio and a cellular telephone. iDEN places 
more users in a given spectral space, compared to analog cellular systems, by using TDMA. 
Six communication channels share a 25 kHz space; some competing technologies place only one 
channel in 12.5 kHz.

i.e.

Do not use. Use that is instead.

IM (Instant Messaging)

A popular use of the Internet in which connected people send messages in real-time by typing 
them into an application window on their computer screens. Each person sees what the other has 
typed, and can respond instantly. Popular instant messaging services are currently not cross-
compatible, and include AOL, Yahoo, iChat, Trillian, and MSN.

IMS (IP Multimedia Systems)

An extension of the GSM/3GPP core network. IMS uses SIP (Session Initiation Protocol) 
to set up, maintain, and terminate packet-switched voice and multimedia sessions. IMS can 
use both the GERAN (GSM/EDGE RAN Radio Access Network) and the WCDMA UTRAN radio 
access networks. 

in

Not capitalized in a title or heading — unless it is the first word.

inbox

One word, lowercase (similar to mailbox). Only capitalize when referring to a specific inbox, 
such as the Outlook Inbox.
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inactive

In technical documentation, use when referring to a feature that is not currently available. 
Can also use grayed-out.

in conjunction/in conjunction with

Do not use. Use with instead.

index

In technical documents, indexes should have no more than two levels (primary and secondary). 
Primary level heads should be capitalized. Secondary level heads are lowercase, unless they are 
acronyms or proper names.

There should be no page numbers next to primary heads when there are secondary heads 
beneath it. References to other entries should have the words see and see also italicized. 
Use see when referring the reader to a completely different entry to get the information. 
Use see also when referring the reader to another entry to get additional information.

EXAMPLE

Mobile 365

contacting, 3-10

creating objects, 3-4 to 3-6

See also contacting

Mobile 365, Inc.

indexes

Plural of index.

indices

Do not use as the plural of index. Use indexes instead.

inhouse

One word, no hyphen.

CORRECT: The newsletter is an inhouse production.

INCORRECT: The newsletter is an in house production.

INCORRECT: The newsletter is an in-house production.

in order to

Avoid using. Use to instead.

inter-operator

Phrase used to describe the capability of Mobile 365 to deliver messages between previously 
incompatible operators, regardless of network type or geographical location. Can also use 
cross-operator or cross-network.

EXCEPTION: If a document is being distributed only in North America, you can use 
cross-carrier or inter-carrier.
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internet

A network of connected networks. A generic term, often preceded by an, which distinguishes it 
from the Internet, which is always capitalized.

Internet

Always capitalize when referring to the worldwide network (the Internet).

intranet

Not capitalized unless it is part of a proper name (“Look it up on the Planet 365 Intranet.”).

ITU (International Telecommunication Union)

An international organization based in Geneva, Switzerland, that is sanctioned and organized 
by the United Nations. The ITU focuses on telecommunications and is divided into three sectors 
dealing with radio communications, standardization, and development.

Many of the global telecommunications standards that are used and relied on today are from 
the ITU or are derived from its work. For example, the standards document called E.164 is the 
standard that describes the structure of a telephone number anywhere in the world.

J
J2ME (Java 2 – Micro Edition)

An application development standard developed by Sun used to download and use wireless 
games and applications on mobile devices. Currently deployed by all GSM operators.

Java

A multiplatform, object-oriented language developed by Sun for use over distributed networks, 
such as the Internet.

JavaScript

Note capitalization. A scripting language designed to run inside Web pages. Other scripting 
languages include: PERL, CGI, ASP, PHP, ColdFusion, and JPS.

justification of text

All written text — in all Mobile 365 documents, both internal and external — should be left justified 
(ragged right edge).

K
keys/key combinations

In technical documentation, do not boldface the names of keyboard keys or key combinations. 
Instead, capitalize the first letter of every word in the key name or key combination. For key 
combinations, use a hyphen to indicate that the keys are pressed simultaneously. Use a space to 
indicate that the keys are pressed in sequence.

EXAMPLES

Press Enter.

To take a screenshot, press Ctrl-Print Screen.

Press Esc N.
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kilobyte (KB)

As a measure of computer memory or storage, a kilobyte is approximately a thousand 
bytes (actually, two to the tenth power, or decimal 1,024 bytes). Note the capitalization in 
the abbreviation.

L
Latin America

Refers to Mexico, Central America, and South America. Contrast Americas, Central America, 
North America, and South America.

launch

Used to describe the act of starting an application.

list box

Do not use. Use scrolling list instead.

lists

Use a comma before the last item in a series of items, before the “and.” In bulleted lists, use no 
punctuation unless each item in the list is a complete sentence. In that case, make each into a 
sentence and use a period at the end of each. Do not use initial capital letters in list items, but do 
capitalize the first word in each item in a bulleted list (even if it isn’t a complete sentence).

CORRECT: Black, green, and white are the Mobile 365 colors.

INCORRECT: Black, green and white are the Mobile 365 colors.

login

Use only as an adjective to describe the a login name. 

EXAMPLE

Log in using your login name.

To access the system, type your login name.

log off

Do not use. Use log out instead.

log in

Two words, no hyphen.

EXCEPTION: When a GUI item is specifically named Login, or when you are using it as an 
adjective (“To access the sysme, type your login name.”).

log on

Do not use. Use log in instead.

log out

Two words, no hyphen.
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longcode

One word. Refers to regular-length phone numbers sometimes used in place of a shortcode. 
Do not use long code or long-code. Longcodes are not often used in the U.S. Contrast shortcode.

lower

In technical documentation, do not use when referring to system software. Use earlier instead.

CORRECT: MMS Exchange does not work with versions earlier than Windows 2000.

INCORRECT: MMS Exchange does not work with versions lower than Windows 2000.

M
machine

Do not use when referring to a computer. Use computer or PC instead.

EXCEPTION: When you are writing about a computer that is running the Unix system, 
use Unix machine.

mcommerce

Note lack of hyphenation and capitalization. Do not use m-commerce, M-commerce, 
or Mcommerce. Contrast ecommerce.

megabite (MB)

As a measure of computer processor storage and real and virtual memory, a megabyte is two 
to the 20th power bytes, or 1,048,576 bytes in decimal notation. Note the capitalization in 
the abbreviation.

menubar

One word. Used to refer to a list of menu items, usually located at the top of an 
application window.

menu

A menu is located at the top of an application window, and is used as a means of choosing one 
action from a list of many actions. In technical documentation, use the following format when 
writing about a menu item:

CORRECT: From the File menu, choose Open.

INCORRECT: Choose Open from the File menu.

MM

Multimedia message.

MM1

Defines the interface between the MMSC and the user agent or handset. MM1 is used to submit 
multimedia messages from the MMS handset to the MMSC, to enable the MMS handset to pull 
multimedia messages from the MMSC, to let the MMSC push information about multimedia 
messages to the MMS handset as part of an multimedia message notification, and to exchange 
delivery reports between MMS Relay/Server and MMS handsets.
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MM3

Defines the interface between the MMSC and existing legacy communication services, such as 
SMS, paging, and email networks commonly in use by operators today. SMS and paging networks 
interconnect through existing protocols such as SMPP, CIMD, etc. Email networks are expected to 
interconnect using SMTP. 

MM4

Used for person-to-person (P2P) MMS messaging. MM4 is a standardized multimedia messaging 
interface that defines the protocol between two MMSCs (or an operator’s MMS infrastructure). 
This is specifically defined in the 3GPP document 23.140. MM4 is built on top of the Simple Mail 
Transport Protocol (SMTP). Mobile 365’s MMS Exchange product uses MM4 to communicate with 
connected operators’ MMSC environments. 

MM5

Defines the interface between the MMSC and the Home Location Register (HLR). The MM5 
specification contemplates using ENUM- and IMSI-based address resolution for global translation 
between MSISDN and SMTP addresses. 

MM7

The protocol used for application-to-person (A2P) MMS messaging. MM7 is a standardized 
multimedia messaging interface that defines the protocol between an MMSC and a third-party 
application. MM7 uses SOAP (Simple Object Access Protocol) as its defined protocol. Mobile 365’s 
A2P MMS hub supports MM7, in addition to EAIF.

MMS (Multimedia Messaging Service)

The transmission of messages that can include text, images, sounds, video, and graphics, 
and which are sent to and from a mobile device. Also called picture messaging.

MMSC (Multimedia Messaging Service Center)

The computer(s) within a wireless service provider’s network that provides the routing of all MMS 
or multimedia messages. Similar to an email server, the MMSC handles large volumes of messages 
sent between two mobile phones, a mobile phone and a software application, or to other MMSCs 
through an intermediary — such as Mobile 365. Contrast SMSC.

MO (Mobile Originated)

Be it SMS or MMS, MO refers to a message you send from your mobile device. See also MT.

Mobile 365, Inc.

At the first mention of the company name (and wherever else it serves as clarification), this is the 
way it should be written. Always use a space between Mobile and 365. Never use it as 
one word.

NOTE: Do not use M365 as a short version of the company name. Always spell out the entire 
company name.

mobile devices

Use when discussing mobile devices (phones, PDAs, pagers, and so on) as a grouping. Can also 
use wireless devices.

mobile phone

Use instead of cell phone. May also use handset and mobile device, where appropriate.
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MT (Mobile Terminated)

Be it SMS or MMS, MT refers to a message you receive on your mobile device. See also MO.

N
newer

In technical documentation, do not use when referring to system software. Use later instead.

CORRECT: MMS Exchange requires Windows 2000 or later.

INCORRECT: MMS Exchange requires Windows 2000 or newer.

North America

Refers to the United States, Canada, Mexico, and the Caribbean. Contrast Americas, 
Central America, Latin America, and South America.

number portability

Describes the capability of individuals, businesses, and organizations to retain their existing 
telephone number(s) — and the same quality of service — when switching to a new local service 
provider. Can also use Wireless Number Portability or WNP.

numbering vs. bullets

Only use a numbered list if you are writing steps in a technical writing procedure. Use bulleted 
lists in all other instances.

numbering

In technical documentation with multiple chapters, figures and tables should be numbered 
consecutively within each chapter. For example, Table 3.5 is the fifth table in Chapter 3. The initial 
reference to a figure or table should come before the figure or table. Any lengthy description 
should follow in the form of a note or paragraph.

When writing a document with no distinct chapters, number figures sequentially (1, 2, 3, 4, 
and so on).

numbers

Spell out numbers from one to ten (unless they are used in direct reference to computer 
technology). Use numerals for the number 11 and higher.

EXAMPLE

The manual contains 200 pages, has 27 chapters, and weighs three pounds.

O
offline

One word, no hyphen. Compare online.

older

Do not use when referring to system software. Use earlier instead.

CORRECT: MMS Exchange does not work with versions earlier than Windows 2000.

INCORRECT: MMS Exchange does not work with versions older than Windows 2000.
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OMA (Open Mobile Alliance)

An organization with broad wireless industry participation that seeks to establish standards that 
foster interoperability between mobile devices and services. Includes the WAP Forum, Wireless 
Village, Location Interoperability Forum, SyncML Forum, and several others. 

on

In technical documentation, use when referring to a button on a toolbar. Do not use from.

CORRECT: On the toolbar, click Create.

INCORRECT: From the toolbar, click Create.

online

One word, no hyphen. Compare offline.

online help

Note lack of hyphenation and capitalization. Capitalize only when referring to a specifically named 
help system, such as Content Manager Online Help.

onscreen

One word. Refers to what is on a computer’s monitor.

operator

Use when referring to all international mobile service providers. Do not use carrier.

EXCEPTION: If a document is being distributed only in North America, you can use carrier.

Operator Charging Gateway (OCG)

Always spell out the first reference in any document, and use the acronym from that point 
forward. The OCG is a mediation billing platform that enables mobile content providers to charge 
subscribers from any connected mobile network — directly to their mobile phone bill.

opt-in

Note hyphenation. Used to describe a mobile user who has opted to receive SMS or MMS 
messages to be sent to his or her mobile device.

opt-out

Note hyphenation. Used to describe a mobile user who has opted not to receive SMS or MMS 
messages to be sent to his or her mobile device.

OR

In technical documentation procedures, if there are two different options the end-user can take to 
accomplish a step, separate them onto different lines with an OR.

EXAMPLE

1. To create a new object, click Create.

OR

From the Action menu, choose Create.
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P
P2P (Person-to-Person messaging)

Defines a type of messaging (either text or multimedia) that is transmitted between two (or more) 
people or mobile handsets. Contrast A2P.

patents

Mobile 365 maintains an active patent program to protect both new and inventive technologies, 
products, and services.

For more information on patents, please see page 40, “Trademarks, Copyrights, + Patents.”

passive voice

Do not use. Use active voice instead.

CORRECT: The dialog displays.

INCORRECT: The dialog will display.

PLMN (Public Land Mobile Network)

A mobile telephone company’s network. 

pane

In technical documentation, do not use to describe a portion of a Web page. Use frame instead.

PC (Personal Computer)

Use acronym instead of machine. Can also use computer. There is never a need to spell out 
the words.

PDA (Personal Digital Assistant)

A portable computing device capable of transmitting data. Use PDA for all references; there is 
rarely a need to spell out the acronym. Can also use handheld or mobile device.

peer-to-peer

Do not use to refer to mobile person-to-person messaging. Use P2P instead.

phone numbers

Global office phone numbers are written with variations in spacing. There is no standard —  
it changes country to country, and phone company to phone company. Use spaces to separate 
groupings of numbers. Do not use periods or dashes.

Following are current Mobile 365 global office phone numbers, including country codes:

Headquarters (Washington, D.C.): +1 703 961 8300

China (Beijing): +86 10 5869 3480

China (Guangzhou): +86 20 3879 1465/2887

China (Shanghai): +86 21 6207 6580/6581

Australia (Sydney): +61 2 9251 8733 

France (Paris): +33 1 53 05 29 00 

Germany (Hamburg): +49 40 271 656 0

List continued on next page
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Hong Kong: +852 2251 8686

India (New Delhi): +91 124 4115264

Italy (Milan): +39 02 584 421 10

Malaysia (Kuala Lumpur): +60 3 6203 2713/2715

Mexico (Mexico City): +52 55 5343 8861

Singapore: +65 6836 4430 

South Africa (Johannesburg): +27 11 467 6981

Spain (Madrid): +34 91 310 0675

Taiwan (Taipei): +886 2 2718 2191

United Kingdom (London): +44 207 357 9044

United States (Los Angeles): +1 310 927 9554

United States (New York): +1 212 873 2131

United States (San Francisco): +1 650 638 4150

United States (Seattle): +1 206 780 9990

Planet 365

The Mobile 365 intranet, accessible at https://planet365.mobile365.com. Planet 365 offers a 
wide variety of corporate documents and information, including templates, sales and marketing 
collateral, employee contact information, industry polls, messages from specific departments, 
pictures from Mobile 365 events, and so on. Also known as The Planet in Mobile 365 slang.

plurals

When making acronyms plural, add an s with no apostrophe (unless it is possessive).

CORRECT: The APIs were finished and ready for release.

INCORRECT: The API’s were finished and ready for release.

pm

Refers to the afternoon and evening hours of the day, from noon to 11:59 pm. Always use in 
lowercase, with no periods after the letters. Do not use the forms P.M., PM, or p.m.

pop-up menu

Do not use. Use pull-down menu instead.

possessives

Avoid using the possessive form of product names, if possible.

CORRECT: The MMS Exchange reporting feature…

INCORRECT: MMS Exchange’s reporting feature…

press

In technical documentation, use press to describe what you do to a key on a keyboard — do not 
use hit or depress.



Mobile 365 Style Guide  27
© 2006 Mobile 365, Inc. All Rights Reserved.

Confidential and proprietary. May not be reproduced or distributed without the express written consent of Mobile 365, Inc. 27

procedures

In technical documentation, procedures are step-by-step instructions used to guide a user on 
how to complete a step or series of steps that result in an action. 

When creating procedures, never separate a procedure from its result by including graphics, 
notes, or page breaks between the step and its result. Number all steps in a procedure, even if 
there is only one step. Every procedure should end with a result.

product names

Product names are written in plain text. They are not bolded or italicized. Avoid using possessive 
forms of product names, if possible. 

CORRECT: The reporting feature in MMS Exchange…

INCORRECT: MMS Exchange’s reporting feature…

Do not break a line in the middle of a product name or company name. For example, Mobile and 
365 should always be kept on the same line. If the 365 breaks to the next line, manually force the 
word Mobile down a line so they stay together. Also refer to proper names.

program

Do not use to describe a software application. Use application or product. A program refers to an 
A2P mobile service conducted on behalf of a client.

proper names

Keep proper names together on the same line. If a proper name, such as Mobile 365, gets 
separated by the end of a line, manually force the word Mobile to the next line to keep the 
words together.

PSMS (Premium SMS)

SMS with a commerce variable that enables one to charge premium rates to a 
dedicated recipient.

PSTN (Public Switched Telephone Network)

The complete set of global, voice-oriented public telephone networks. Often referred to as the 
Plain Old Telephone Service (POTS), the PSTN is a vast aggregation of circuit switching telephone 
networks that spans the globe.

pull SMS

The ability to request services (e.g. ringtones or games) from a wireless handset via wireless 
Internet. The requested service is sent back to the handset via SMS. Contrast push SMS.

pull-down menu

Always hyphenate. Do not use pulldown or pull down. This type of menu has a down arrow to its 
right to indicate additional choices. Do not use drop-down menu or pop-up menu.

punctuation

Use only one space after periods, commas, hyphens, semi-colons, and colons. Use no spaces 
before or after an em dash. Use no spaces before and after slash marks.

Don’t use periods at the end of bulleted list items unless every item in the list is a complete 
sentence. In this case, each item in the list should be made into a complete sentence, and should 
have a period. Never use semi-colons at the end of items in a bulleted list, and don’t use them to 
replace the function of commas in a series list.
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push SMS

The ability to request services (e.g. ringtones or games) from a wireless handset via sending a 
preset SMS code to a predetermined number. The requested service is sent back to the handset 
via SMS. Contrast pull SMS.

Q
quotation marks

Please use “smart quotes” for quotation marks (also referred to as curly quotes or typographer’s 
quotes). Smart quotes are generally considered to be more readable than straight quotes.

To turn on smart quotes in Microsoft Word, go to the Tools menu, choose AutoCorrect Options, 
and then click the AutoFormat As You Type tab. In the Replace as you type section, click the 
“Straight quotes” with “smart quotes” checkbox. Click OK.

When quoting within a quote, use a single quote.

CORRECT: “She said, ‘Hurry up, I need the manual soon.’”

INCORRECT: “She said, “Hurry up, I need the manual soon.””

R
radio buttons

In technical documentation, radio buttons are small, round buttons in a GUI that enable the end-
user to select between options (they cannot pick more than one). Contrast checkboxes, 
with which users may make multiple selections.

RAN (Radio Access Network)

The portion of a mobile network that handles subscriber access, including radio base stations and 
concentration nodes.

real-time

Always hyphenate.

registered trademark

Include the following statement at the back of your document to mention all registered 
trademarks, trademarks, trade names, and service marks:

Mobile 365 maintains an active and comprehensive Intellectual Property program, including 
issued patents and pending patent applications, to protect key elements of Mobile 365 
technology. Third-party names, products, and marks mentioned herein describe and refer to 
such third parties and their respective products and/or their respective owners. Mobile 365 
makes no claim thereto, and uses such names and/or marks only to describe third parties and 
their respective products and/or services. Such use is not an endorsement or sponsorship by 
such third parties of Mobile 365-provided products and/or services.

For more information on trademarks, please see page 40, “Trademarks, Copyrights, + Patents.”
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result

In technical documentation, a result states the outcome achieved by following a step-by-step 
instructional procedure. Never separate a result from its procedure. A result should always be 
preceded by a checkmark, indicating the result of an action performed by the user.

EXAMPLE

1. From the File menu, choose Open.

√ The Open dialog displays.

ringtone

One word. A ringtone is a sound, usually customizable, that a mobile phone makes when receiving 
an incoming phone call. Ringtones were originally conceived to provide a method of identifying 
one’s mobile phone in the company of other mobile phones. Today’s mobile phones can store and 
utilize ringtones that are actual music clips, real-life sounds, or synthesized sounds.

S
screen

In the mobile space, this refers to a phone’s screen.

In technical writing, this refers to a computer’s monitor, upon which information, programs, 
and GUIs display. Also refers to a screen that displays in an HTML-based application. Do not use 
page to describe this screen.

EXAMPLE

User details display in the User Management screen.

screenshot

One word. Use the real name of a screenshot as the caption the first time the screen displays 
(such as The Object Creation Window). After that, the captions can be more descriptive, such as 
Creating a New Object.

In technical documentation, do not refer to a screenshot that is more than two pages away from 
the reference — repeat the screenshot instead.

scrolling list

Use instead of list box.

second person

When writing, use whenever possible. Do not use the third person.

CORRECT: Click OK.

INCORRECT: The user should click OK.

select

Do not use when referring to menu items. Use choose instead. Use select when choosing an 
option from a list with a dialog.

CORRECT: From the File menu, choose Open.

INCORRECT: From the File menu, select Open.
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semi-colon

Use a semi-colon to separate clauses when there is no and in between.

EXAMPLE

The OCG is Mobile 365’s most important product release to date; it will help lead the 
company to the forefront of the mobile billing space.

Also use semi-colons to separate items in a series when there is already a comma in one or more 
of the items.

EXAMPLE

Mobile 365’s best-selling attributes are network reliability, which attracts operators;  
global reach; our presence in many countries; and our vast experience.

Do not place a semi-colon after each item in a bulleted list, and do not use them to replace the 
function of commas in a series list.

CORRECT: The Mobile 365 colors are black, green, and white.

INCORRECT: The Mobile 365 colors are black; green; and white.

SGSN (Serving GPRS Support Node)

The SGSN handles the data traffic of users in a geographical service area, and is one of the two 
types of nodes implemented in a GPRS environment. Contrast GGSN.

shortcode

One word. Refers to truncated phone numbers that can be leased from operator networks and 
used in a mobile marketing campaign (for example, “To vote for your favorite singer, text the 
singer’s name to 99999!”). Do not use short code or short-code. Contrast longcode.

SIP (Session Initiation Protocol)

A core protocol in IP multimedia systems (both wireless and fixed networks). The primary 
purpose of SIP is to set up a call or communication between two entities — such as handsets or 
applications used — to send/receive messages that support voice, audio, images, and video.

SMPP (Short Message Peer-to-Peer)

An IP-based protocol used to transmit SMS messages between application servers and SMSCs, 
or between two SMSCs. Mobile 365 uses SMPP for most of its P2P interoperability services.

SMPP was first a proprietary protocol, defined by Logica-Aldiscon (now LogicaCMG); it is now 
maintained by the SMS Forum.

SMS (Short Message Service)

The transmission of short text messages to and from a mobile device. Messages must be no 
longer than 160 alphanumeric characters, and can contain no images or graphics.

SMSC (Short Message Service Center)

The computer(s) within a wireless service provider’s network that provides the routing of all 
SMS or text messages. Much like an email server, the SMSC handles large volumes of messages 
sent between two mobile phones, or between a mobile phone and a software application. 
Contrast MMSC.
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SOAP (Simple Object Access Protocol)

An XML-based language used for exchanging data between Internet applications on 
different computers.

South America

Refers to Brazil, Argentina, Chile, Colombia, Ecuador, Venezuela, Uruguay, Paraguay, Bolivia, 
Peru, Guyana, Suriname, and French Guiana. Contrast Americas, Latin America, Central America, 
and North America.

SS7 (ITU common channel Signaling System 7)

A set of low-level protocols used to control activities in telecommunications networks. SS7 
is used in both fixed and mobile networks, and is the basis for GSM, CDMA, and TDMA mobile 
networks. In some European countries, specifically the United Kingdom, it is sometimes referred 
to as C7.

startup

One word. A company born in a garage, according to ancient Silicon Valley lore.

subheading

One word, no hyphen. To provide clarity in Microsoft Word documents, always include a short 
introductory paragraph following headings, subheadings, or sub-subheadings.

subscribers

Describes the clients of Mobile 365 customers, the people who buy and use mobile devices. 
Can also use end-users.

subscription

A product or service initiated by a subscriber to receive content on an ongoing basis, 
typically with periodic premium billing events. It is not a one-time usage service.

sub-subheading

Note hyphenation. To provide clarity in Microsoft Word documents, always include a short 
introductory paragraph following headings, subheadings, or sub-subheadings.

T
tables

In technical documentation, tables are numbered consecutively within each chapter. For example, 
Table 3.5 is the fifth table in Chapter 3. The initial reference to a table should come before 
the table. When writing a document with no distinct chapters, number tables sequentially 
(1, 2, 3, 4, and so on).

Any lengthy description of a table should follow in the form of a callout or paragraph. Put a 
double line, not a thick single line, under a heading row.
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TDMA (Time Division Multiple Access)

A digital wireless telephony transmission technique that allocates each user a different time 
slot on a given frequency. GSM and other wireless transmission techniques use TDMA in one 
form or another. TDMA has also been called D-AMPS. TDMA networks are operated in the U.S., 
Latin America, New Zealand, parts of Russia, and Asia-Pacific. Most are slowly being overlaid, 
however, and will ultimately replaced by GSM (and occasionally CDMA). 

terabyte (TB)

A terabyte is a measure of computer storage capacity, and is two to the 40th power or 
approximately a thousand billion bytes (that is, a thousand gigabytes). Note the capitalization in 
the abbreviation. 

text justification

All written text — in all Mobile 365 documents, both internal and external — should be left justified 
(ragged right edge).

that

Use in essential clauses not set off by commas. Use which only in unessential clauses set off 
by commas.

EXAMPLES

The exam that was five pages long proved much less difficult than I expected.

[The five-page exam was less difficult than any other exam.]

The exam, which was five pages long, proved to be far less difficult than I expected.

[The exam, which happened to be five pages, was much less difficult.]

the

Not capitalized in a title or heading — unless it is the first word.

third-party/third party

Hyphenate when used as an adjective. Use without a hyphen when used as a noun.

EXAMPLE

Third-party names, products, and marks mentioned herein describe and refer to a third party 
and their respective products. 

third person

When writing, do not use. Use the second person instead.

CORRECT: Click OK.

INCORRECT: The user should click OK.

this

Not capitalized in a title or heading — unless it is the first word.

toolbar

One word. A strip of buttons providing shortcuts to the functions of a software application.
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TPOA (TP Originating Address)

A parameter of the GSM MAP protocol definition for SMS. The originating address can be 
expressed as both a number and an alphanumeric string. In many A2P ecosystems, the TPOA 
may be expressly set so subscribers can see an easily identifiable originator, rather than an 
obscure phone number.

trademarks

Include the following statement at the back of your document to mention all registered 
trademarks, trademarks, trade names, and service marks:

Mobile 365 maintains an active and comprehensive Intellectual Property program, including 
issued patents and pending patent applications, to protect key elements of Mobile 365 
technology. Third-party names, products, and marks mentioned herein describe and refer 
to such third parties and their respective products and/or their respective owners. Mobile 
365 makes no claim thereto, and uses such names and/or marks only to describe third 
parties and their respective products and/or services. Such use is not an endorsement or 
sponsorship by such third parties of Mobile 365-provided products and/or services.

When writing the company name for the first time in a document, write is as follows: Mobile 365, 
IncTM (including the trademark symbol). Subsequent references can be simply Mobile 365.

For more information on trademarks, please see page 40, “Trademarks, Copyrights, + Patents.”

type

Use when referring to typing information using the keyboard. Do not use type in or enter.

CORRECT: When prompted, type your password.

INCORRECT: When prompted, type in your password.

INCORRECT: When prompted, enter your password.

U
UI (User Interface)

A program interface that takes advantage of the computer’s graphics capabilities to make the 
program easier to use. There is never a need to spell out the acronym. Can also use GUI.

UMTS (Universal Mobile Telecommunication System)

The standard for the third generation, generally based on WCDMA (Wideband Code Division 
Multiple Access). UMTS launched in 2002. UMTS is standardized by the 3GPP, and represents the 
European answer to the ITU IMT-2000 requirements for 3G cellular radio systems.

Unix®

Unix is a registered trademark, and is also an adjective. When writing about a computer running 
the Unix system, refer to it as a Unix machine.

URL (Uniform Resource Locator)

The address of a Web page or an FTP site. It is never necessary to spell out the acronym.

user ID

Two words, capitalized ID.
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username

One word.

V
version numbers (in filenames)

When naming a file, always use the following format: documentname_V1_15March2006.xxx

NOTE: Always put a document version number in both the document footer and the 
document filename. 

W
wallpaper

A picture or image on the background of your mobile device.

NOTE: Use wallpaper as one word, with no hyphen or space. Do not add an s to make it plural.

WAP (Wireless Application Protocol)

The worldwide standard for accessing the Internet via wireless devices. WAP defines the structure 
and semantics of the Wireless Markup Language (WML). WAP was conceived by four companies: 
Ericsson, Motorola, Nokia, and Unwired Planet (then called Phone.com, now part of Openwave). 
WAP was originally maintained by the WAP Forum, which was rolled up into the OMA (Open Mobile 
Alliance) consortium.

WCDMA (Wideband Code Division Multiple Access)

A wideband spread-spectrum 3G mobile telecommunication air interface that utilizes code 
division multiple access (or CDMA, the general multiplexing scheme — not to be confused with 
CDMA, the standard). WCDMA is a 3G mobile communications standard allied with GSM. WCDMA 
is the technology behind UMTS.

Web

Always capitalize.

Website

One word, no spaces. Always capitalize the W.

which

Use only in unessential clauses set off by commas. Use that in essential clauses (not set off 
by commas).

EXAMPLES

The exam, which was five pages long, proved to be far less difficult than I expected.

[The exam, which happened to be five pages, was much less difficult.]

The exam that was five pages long proved much less difficult than I expected.

[The five-page exam was less difficult than any other exam.]
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Wi-Fi (Wireless Fidelity)

A trademark of The Wi-Fi Alliance. The Wi-Fi Alliance (formerly WECA) is the global Wi-Fi 
organization that created the Wi-Fi brand. A nonprofit organization, the Alliance was formed 
in 1999 to certify interoperability of IEEE 802.11 products and to promote them as the global, 
wireless LAN standard across all market segments. The Wi-Fi Alliance has instituted a test suite 
that defines how member products are tested to certify that they are interoperable with other 
Wi-Fi certified products.

WiMax (Worldwide Interoperability for Microwave Access forum)

WiMax is the interoperability brand behind the IEEE 802.16 specification for Metropolitan Area 
Network standards. WiMax is based on Wi-Fi in relation to IEEE specification 802.11.

window

In technical documentation, a window displays when you double-click an icon, and it has a close 
box. A window has options to click, select, or set. A window displays, it does not appear.

NOTE: Do not use window when discussing part of an HTML page; use frame instead.

wireless

One word. Can also use mobile.

wireless devices

Use when discussing wireless devices (phones, PDAs, pagers, and so on) as a grouping. Also use 
mobile devices.

Wireless Number Portability (WNP)

Describes the capability of individuals, businesses, and organizations to retain their existing 
telephone number(s) — and the same quality of service — when switching to a new local service 
provider. Can also use number portability.

with

Not capitalized in a title or heading — unless it is the first word.

WLAN (Wireless Local Area Network)

Usually operating as a Wi-Fi network. 

worldwide

Note lack of hyphenation.

CORRECT: Mobile 365 has a worldwide network of resellers.

INCORRECT: Mobile 365 has a world-wide network of resellers.

World Wide Web (WWW)

Note lack of hyphenation in the spelled-out word. There is rarely a need to use the acronym. 
The Mobile 365 URL is written as follows: www.mobile365.com.
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Y
you want to

In technical documentation, do not use this phrase. Leave it in only if it clarifies meaning.

CORRECT: From the File Type menu, choose a format in which to save the page.

CORRECT: From the File Type menu, choose a format in which you want to save the page.

your

In technical documentation, use your only if what you are referring to is part of the user’s system. 
Use the generic the if it is not part of the user’s system.

EXAMPLES

Open the Extensions folder.

Open your Extensions folder.
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Document Style Guidelines

Document Templates: Visit the Planet!
Mobile 365 has numerous document templates, depending on your needs. All templates are 
available on Planet 365, which is located at https://planet365.mobile365.com. 

Available templates include:

• A Word template that can be used to create reports, white papers, technical documents, 
and general documents

• A PowerPoint template for presentations

• U.S. and A4 versions of our corporate letterhead

• Fax cover sheets

On Planet 365

Documents > Templates

What Document Type Do I Need?
Should your document take the form of a fax, a PowerPoint presentation, a Word document, or an 
email? The following guidelines may help you decide which format your outgoing communication 
should take. The document templates available on Planet 365 include the correct corporate 
fonts, styles, title page design, table of contents design, and so on. Downloadable (soft) copies are 
located in the Documents/Templates section of Planet 365.

Letters
Letters are primarily used as a means of formal external communication with customers, 
shareholders, partners, and the like. Letters should be printed on official Mobile 365 letterhead; 
each office has printed letterhead featuring their address information. You can also use one of 
several online templates located on Planet 365; there are both U.S. and A4 versions available.

NOTE: None of the online templates contains specific office information. Please add this 
information yourself.

White Papers, Technical Documents, Reports, etc.
The Word template can be used to create a wide variety of documents, ranging from white papers 
to technical documents to general documents. The Word template is updated regularly; please use 
the template to build each new document you produce. Do not use old templates, as they will not 
contain the most recent changes to the company boilerplate information and updated styles.

PowerPoint presentations
PowerPoint presentations are used as visual guides for public speaking, and can be used for sales 
pitches, speaking opportunities, and the like. Every formatting style needed to create an effective 
PowerPoint presentation exists in the template. Please do not change any elements of the 
template, including font type, font size, artwork, and location of logos.

NOTE: Always use the current template, available on Planet 365, to build each new 
presentation, as items in the template change regularly.

For details on using the Mobile 365 PowerPoint template — and for guidance on the layout of 
technical documents — please refer to the Mobile 365 Brand Guide.
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Technical Documents
Mobile 365 produces several types of technical documents. Most have a dual life as both client-
facing documents and as documents intended for internal use. These documents can include 
proposals, wizard documents, technical qualifications documents, requirements documents, 
training guides, and technical specifications.

NOTE: End-user documentation, created for use by our customers, is managed by the 
Technical Documentation branch of the Corporate Marketing department. For more 
information, please send email to Greg Matranga at greg.matranga@mobile365.com.

Formatting: Boldface vs. Italics vs. Underline
Always use formatting sparingly in professional communications. 

• Italics are typically used to refer to a formal publication or to cross-reference another 
document or section of a document.

• Boldface is commonly used when referring to named items in a GUI, such as field names or 
menu items (for example: “From the File menu, choose Open.”).

• Underlined text is difficult to read (especially when faxed). Avoid using it.

Graphics in Microsoft Word + PowerPoint
To import a graphic into a Word or PowerPoint document, go to the Insert menu, and choose 
Picture/From File…. Navigate to the graphic you want to include, highlight it, and click Insert.

To take a screenshot of your active (frontmost) window and paste it into a Word or PowerPoint 
document, press the Alt-Print Screen keys on your keyboard. Paste the screenshot into your 
document using the Paste command under the File menu (or by right-clicking and choosing Paste 
from the pop-up menu).

How to Build a Table of Contents in Word
Once you have constructed your document, you need to build your table of contents (using the 
preset styles in the Microsoft Word template).

To create a table of contents in Word:

1. From the Insert menu, choose Reference/Index and Tables….

2. Click the Table of Contents tab.

3. Click the Show Page Number and Right Align Page Numbers checkboxes.

4. From the Tab Leader pull-down menu, choose the solid line.

5. From the Formats pull-down list, choose Formal.

6. In the Show Levels field, choose 3.

7. Click OK.

√ Your table of contents automatically reformats.

NOTE: If you make any changes to the document, you need to update your table of contents. 
This can be done by highlighting the table of contents, right-clicking, and choosing 
Update Field. Then click the Update entire table radio button, and click OK.
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Email Style Guidelines
This section discusses email styles, and it guides you on how to develop an email signature that 
adheres to the Mobile 365 style. There are two email signature styles from which to choose, 
both of which are shown below.

Writing Style
Remember that all external email is considered official contact with customers and potential 
clients. As such, always craft email messages using a formal tone, and please proofread and 
spellcheck all email messages before sending.

Font and Font Size
The recommended font and size is Verdana, 10 point.

Signature Style
Please create your signature in the following format:

First and last name (in bold)

Title

Mobile 365 (the whole line is bold, and “365” is in Mobile 365 green)

<local office address, if desired>

Tel: +1 703 961 8300

Fax: +1 703 961 8308

Mobile: +1 703 863 7768

firstname.lastname@mobile365.com (bold, and in Mobile 365 green)

www.mobile365.com (bold, and in Mobile 365 green)

Email sig file with no office address Email sig file featuring office address
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Trademarks
Include the following statement at the back of your document to mention all registered 
trademarks, trademarks, trade names, and service marks:

Mobile 365 maintains an active and comprehensive Intellectual Property program, including 
issued patents and pending patent applications, to protect key elements of Mobile 365 
technology. Third-party names, products, and marks mentioned herein describe and refer 
to such third parties and their respective products and/or their respective owners. Mobile 
365 makes no claim thereto, and uses such names and/or marks only to describe third 
parties and their respective products and/or services. Such use is not an endorsement or 
sponsorship by such third parties of Mobile 365-provided products and/or services.

When writing the company name for the first time in a document, write is as follows: 
Mobile 365, IncTM (including the trademark symbol).

Subsequent references can be simply Mobile 365.

Adding a TM Symbol into a Word Document
To add a trademark symbol into a Microsoft Word document, type Alt-Ctrl-T at the end of the 
trademarked word or phrase. The TM is automatically superscripted.

Adding a TM Symbol into a PowerPoint Document
To add a trademark symbol into a Microsoft PowerPoint document, place your cursor at the end 
of the word or phrase where the TM symbol is required. From the Insert menu, choose Symbol. 
In the Symbol dialog, choose the TM symbol and click Insert. To close the window, click Close. 
The TM is automatically superscripted.

Copyrights
A copyright statement shall be included in each Mobile 365 document at the time that such 
document is produced. Use the following copyright statement in the footer of all external Mobile 
365 documents: © 2006 Mobile 365, Inc. 

Patents
Mobile 365 maintains an active patent program to protect both new and inventive technologies, 
products, and services.

Products and services offered by Mobile 365 may be covered by one or more of the following 
patents: China 00120173.5; France 2792292, 2806179, 2806860, 2821255, 2825555, 2833127, 
2838264; Hong Kong 1025476, 1034012; Ireland 82374, 83427; Italy 1317413; Netherlands 
1015013, 1020724; Sweden 520596; Taiwan 195407; U.K. 2376154; U.S. 6512926, 6832089, 
7003306, 7013156; and/or pending patent applications.

Trademarks, Copyrights, + Patents


